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In the electric utility industry, it seems that everything we design is “just like that one, only different." If you can relate to 
this statement, then this hands-on lab is for you. You will gain the ability to increase accuracy, quality, and productivity 
while improving Building Information Modeling (BIM) workflows when designing electric utility substations using 
Autodesk® Inventor® software. We demonstrate sketching techniques you can use to easily alter standard content. 
We show examples of creating, copying, and using standard 3D models to fit any unique situation. Finally, we take 
you through the procedures to create and update an accurate parts list and quality drawings in a matter of minutes. 

Learning Objectives 
At the end of this class, you will be able to: 

 Create standardized content using improved sketching techniques 
 

 Alter standard models to fit any unique application 
 

 Quickly generate quality construction drawings 
 

 Create an accurate parts list using intelligent 3D models 
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Institute.  She is employed as the Principal Associate Engineer in Substation Design at Nashville Electric 
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 Create standardized content using improved sketching techniques 

Where to begin? 
It all starts with a sketch that becomes a part and that part is placed in an assembly.  The first exercise 

involves using a specialized template to create a structural part.  The iProperties are set in the template to 

populate the Bill of Material with the information required.  By using parameters in a formula, the 

description in the iProperties automatically changes as the sketch dimensions are modified. The next 

exercise uses the dimensional constraints in the sketches for a typical circuit breaker to change the 

critical dimensions.  This allows one library part to be used for several types of breakers. 

Part Template 

1. Open the Folder “WorkSpaceAU13” from the Desktop.  Open the file PLATE TEMPLATE. 

                              

2. Open the iProperties dialog box and click on the Project Tab.  The parameter symbol to the right 

of the description property indicates the description is a formula.  Close the iProperties.   

 

             
 

 

 

 

 

 

 

Pick to toggle 

between formula 

and description 

Open from 

Desktop 
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3. Change the value of the “LTH” and “WTH” dimensions to 18.  Click the Update icon to implement 

the new dimension values.  Turn off the visibility of Sketch1. 

                                    

                                         

4. Change the value of the “THK” parameter to 1” either by opening the Parameter dialog box or 

double click on Extrusion1.         

                  
OR 

                        

Change the 

value of 

“LTH” to 18 

Change the value of 

“WTH” to 18  

Click Update 

Turn off 

visibility 

Change 

value to 1 

as shown 

Change 

value to 1 

as shown 

Double click 

to change 

value to 1 

as shown 
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5. Open iProperties and click on the Project Tab.  Notice the description has automatically been 

updated by the parameters in the formula. 

                              

6. Save and close the PLATE TEMPLATE. 

Typical Circuit Breaker 

1. Open the file F23-1200A-22KA.ipt.  To modify the anchor bolt pattern, edit Sketch1.  Replace the 

5’-0” dimension with 4’-0”.  Replace the 4’-0” dimension with 3’-0”.  Finish Sketch. 

             

2. Double click on Work Plane1 to redefine.  Change the distance to 30” and enter. 

                      

1) Double click 

to edit Sketch1 

1) Double click 

to redefine Work 

Plane1 

2) Type in 30 

and pick Check 

Less chance of human error when 

the values in the description 

formula are populated from the 

sketch parameters 

2) Double click 

to edit dimension 

to 4’-0” 

3) Double click to edit 

dimension to 3’-0” 

Enter inch w/o unit 

string or feet with 

unit string 
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3. Edit Extrusion3.  Subtract 15 from existing Distance dimension. 

          

4. Set the View Cube to right.  Expand “iFeature6 to edit Sketch37. Change the value of the 

distance from edge to center point of bushing from 14” to 8”.  Finish Sketch.  

                              

5. Change the View Cube to Home.  Edit Rectangular Patteren1.  Change the value of the spacing 

from 16” to 20”.  From the preview we can tell that the bushings are too close to the edge of the 

breaker.  Change the spacing to 18” and enter. 

                            

1) Expand 

iFeature6, 

Edit Sketch37 

2) Double click on 

dimension to edit 

3) Type in 8 

and Enter 

1) Double click on 

Extrusion3 to edit 

2) Subtract 15 from 

existing dimension 

as shown 

1) Double click to edit  

2) Change the 

spacing to 20  

3) Bushing too 

close to edge 

Change the 

spacing to 18  
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6. Set the View Cube to the Right.  Edit Sketch3.  Change the slope from 3 deg to 6 deg.  Finish 

sketch. 

                    

7. Save and close the file. 

There are several more adjustments that can be made such as relocating the conduit entrance and 

relocating the cabinet door by redefining their sketch.   

 

 Alter standard models to fit any unique application 

Standard Sub-Assembly 

This example shows how to use one Standard Sub-Assembly for multiple applications. The constraint 

relationships between the parts allows the model to adapt to dimensional changes. In the first exercise 

we’ll finish constraining a standard bus support assembly. In the second exercise we’ll convert the 

standard bus support assembly to a 161kV bus support structure. In the third exercise we’ll finish an 

electrical assembly by adding cabling, sizing the switches and completing the three phases.   

Standard Bus Support Model 
1. Open the file STANDARD-BUS-SUP.iam. 

                    .  

1) Double Click 

Sketch3 to Edit 

2) Double Click on 

angular dimension 

to edit 

Open from 

WorkSpaceAU13 

3) Type in 6 and 

Enter 
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2. Create a Circular Pattern of support plate “PL-02” around the Z axis. 

                    

3. Create a Rectangular Pattern of channel CH-01.  Pick the direction by picking an edge.  Highlight 

the spacing value, right click, pick List Parameters and choose “SPC23”. 

                            

1) Select 

direction 

2) Select 

spacing 

“SPC23” from 

parameter list 

2) Select Z axis 

1) Select PL-02 

Z axis 

Direction 

PL-02 

CH-01 
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TYPICAL PHASE TO PHASE SPACING 

User Parameters are set up to correspond to the phase to phase spacing for different voltages as shown 

below.  

 

                                                       

 

 

 

4. Constrain top of square tube “TB-01” to bottom of plate “PL-05”.  The adaptivity of the square 

tube allows the length to adjust according to the constraints 

           

 

 

 

161kV Spacing 

(SPC161) = 9’-0” 

23kV Spacing 

(SPC23) = 3’-6” 
69kV Spacing 

(SPC69) = 6’-0” 

Select bottom of 

plate PL-05 

Select top of 

square tube TB-01 

Adaptive 

icon 
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5. Use the mate constraint to constrain the top of channel CH-01 to the bottom of plate PL-01.  

Change the offset value to “-120” or “-10ft” then click “Apply” 

                                

6. The Standard Bus Support Assembly is complete.  Save as BS-01 to keep the Standard 

Assembly pristine.  (Select “Yes” to replace existing BS-01 file.) 

                

7. DO NOT CLOSE 

Pick “Yes” 

 Type in 

Offset value 

as shown 

Pick the top 

of CH-01 

Pick the bottom 

of PL-01 
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Standard Structural Models  
1. Open 161-BAY-LAYOUT.dwg 

   

2. Open 161-BAY-STR.iam.from the browser under the “Structural” sheet and PLAN1. 

 

                              
 

 

Expand 

PLAN1 

Right Click to 

Open 
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This is the foundations and structures of a Standard Structural Bay Assembly.  In these next steps we will 

convert the Standard Bus Support to a 161kV structure.  The assembly and drawing will automatically 

update as the Bus Support is altered. 

                       

3. Make BS-01 tab current.  Expand TB-01 in the browser.  Double click on the shared Sketch1 to 

edit from assembly.  Double click on the parameter “WALL1”.  Change the value in the Edit 

Dimension box to 6 in. 

 

 
 

 

Standard Bus 

Support Structure 

Standard Bus 

Support Structure  

1) Expand TB-01 

2) Double click Sketch1 

3) Double click 

WALL1 
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4.  Finish the sketch and notice the tube enlarges.  Click “Return” and notice the plates adjust to the 

larger tube.   

                                                                                

5. Expand “Component Pattern 5”.  Right click on Element;2 and pick “Independent”.  Replace the 

Independent PL-02 with PL-04 and ground.  (an Independent Element loses its constraints)   

                              

6. Double click on WB-01 to edit the beam.  Open the Parameter dialog box.  Highlight only 

“SPC23” of the Equation in the “LTH” parameter, right click, and click List Parameters then select 

“SPC161”. Return to the main assembly.  

                                       

1) Double Click on 

WB-01 to Edit  

2) Highlight 

“SPC23”  3) Select 

“SPC161”  

Replace Independent 

PL-02 with PL-04  

Red x represents 

Element2 is 

Independent 

Element  

The constraint relationship causes the 

plate move according to the tube 

dimensional changes  

Ground PL-04  
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7. Double click on “Component Pattern 6” to edit.  To change the spacing of the pattern, click on the 

arrow in the Edit Dimension box and pick List Parameters then select “SPC161”.   

                 

8.  Expand “Component Pattern 6, Element;1 and CH-01.  Double click on Flush;32, click on the 

arrow in the Edit Dimension box, List Parameters and pick “SPC161” then enter.    

  

 
 

 

 

 

1) Double Click on 

Component 

Pattern6 to Edit  

3) Select 

“SPC161”  

2) Right 

click and 

pick List 

Parameters 

1) Expand Component 

Pattern6, Element1 and 

CH-01  

3) Select 

“SPC161”  

2) Right 

click and 

pick List 

Parameters 
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9. Double click on Mate;39.  (This constraint was set in the standard bus support assembly in steps 

4 and 5)  Type in “-18ft” and enter.  Save and Close. 

                      

Standard Electrical Models 
The structure assembly is modified to a 161kV structure.  Now we will complete the electrical assembly. 

 

1. Make drawing 161-BAY-LAYOUT.dwg current.  Activate the Electrical sheet, expand PLAN1 and 

right click on 161-BAY-ELE.iam to open assembly. 

 

            

1) Double Click 

on Mate;38  

2) Enter “-18ft” 

Modified 161kV 

Bus Support 

Structure 

Modified 161kV 

Bus Support 

Structure 
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2. Double click on the switch “SPSWH2000-H01;1 to edit.  Double click on Sketch2.  Double Click 

on dimension “PADHTH” and type in a new value of 77 then enter.   

   

3. Edit Rectangular Pattern3.  Change the spacing by using the parameter “SPC161”.  Click on OK 

and return to assembly. 

 

1) Double 

click to edit 

2) Double click 

and enter 77 

1) Double 

click to edit 

2) Select 

“SPC161” 
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4. Next we will modify or add cabling as required.  First we will re-attach the cabling that lost its 

connection when the switch was modified.  We use the Substation Designer Suite by 

AutomationForce for our cabling. Go to the “Above Grade Tools” and pick the “Update Cable” 

icon. Pick the cable as shown.  Notice the cables reconnect to their corresponding terminal lugs. 

Do this for each cable. 

                                         

5. Pick the “Pick 2 Fittings to Add Cable” icon. Pick the lug on the switch pad then the lug on the 

breaker.  The cable is generated.  Do this for the other leads. 

                                            

2) Select 

Switch Lug 

3) Select 

Breaker Lug 

1) Select “Pick 

2 fittings to 

Add Cables” 

1) Select 

“Above Grade 

Tools” 
2) Select 

“Update 

Cables” 

3) Select 

Cable and 

repeat for 

each cable 
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6. Open the BOM to see how the existing parts are listed.  

 

 

7. Relocate and revise the cable size by selecting “Edit Cable” in the “Above Grade Tools”, pick the 

PT lead. The Edit Bare Cable dialog box opens.  Click on the arrow in the cable size box and pick 

“CABLE ACSR BARE 477 18/1”.  Choose Apply then Done.   

                           

 

 

2) Choose to 

resize cable 

1) Pick PT 

Lead to edit 

4/0 Bare 

CU Cable 

Bus Support Spacer height 

calculated from parameters 
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8. Click on the bus to which the PT lead is attached. Find the highlighted part (SBTA35-AU) in the 

browser and expand. Right click on the greyed out (suppressed) Insert;96. The bus is constrained 

to the switch terminal lug.  Click on “Suppress” to unsuppressed the constraint and watch what 

happens. 

          

 

9. Reopen the BOM to see how the changes affected the listed parts.  

       

 

 

 

1) Pick Bus 

“SBTA35-AU” 

3) Un-suppress 

Insert;96 

2) Expand 

“SBTA35-AU” 

Insert;96 

Surface 1 

and 

Surface 2 

BOM reflects 

the revised 

cable 

Bus Support Spacer 

height is recalculated 
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10. Update the PT lead using the SDS “Above Grade Tool”.  Create a Rectangular Pattern. Click on 

the direction arrow and pick an edge. Make 3 rows and pick the “SPC161” spacing.  Pick the 

component arrow and select each component to be patterned as shown below.                                                   

 
 

11. Repeat patterned component. Select the components as shown below.  Select the correct 

direction choose 3 rows and “SPC161” then click OK. 

              

Select 

to 

pattern 

Select to pattern 

1) Select direction 

2) 3 Rows 

3) Pick Spacing 

1) Select direction 

2) 3 Rows 

3) Pick Spacing 



Designing Substations Part by Part with Autodesk® Inventor® 

 

20 
 

12. The last step in this section is to extend the bus.  Edit Patteren3, expand Element 1, and 

unsuppressed Insert; 95. 

                                      

 Quickly generate quality construction drawings 

Generate Drawings 

This exercise creates a standard drawing.  When the Base View is placed, the Title Block is populated.   

Next, the Views are annotated by placing Dimensions, Balloons and the Parts List. Now replace the 

standard model using the Replace Model Reference tool. The Views, Dimensions, Balloons, Title Block 

and Parts List all update to the values of the new model automatically.  Some clean-up is usually 

required, such as moving dimensions, changing scale, sorting the Parts List, etc. 

  Standard Drawings  

1. Make the 161-BAY-LAYOUT.dwg current. Activate the “Structure-Det” sheet. Open the Base 

View dialog box.  Browse to open “BS-00”.  In the Base View dialog box, change the scale to 

½”=1 and turn off the View Label visibility.  Place the front view, drag up to place the top view, 

right click then pick “Create”. 

                     

1) Edit Component 

Pattern3 

1) Browse to BS-00 

and open 

2) Change 

scale to 

½”=1’ 

3) Turn off 

View Label 

visibility 

4) Drag up to 

create top view 

3) Un-suppress 

Insert;95 

2) Expand 

Element1 and 

“SBTA35-AU” 
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2. Place Dimensions as shown.  To place Balloons, right click and select the Balloon button.  Pick 

the beam WB-00 in the structure as shown.  In the BOM Properties dialog box, click on the arrow 

in the “BOM View” box and select “Structured”. Click OK, place the Balloon, right click, pick 

“Continue” and repeat.   

                             

3. Place “Leader Text” pointing to the column TB-00.  In the Format Text dialog box, pick “Properties 

– Model” from the “Type” menu.  Then from the “Properties” menu, pick “Description”.   

                        

4. To place the Parts List, select the icon from the Annotate tab.  Select the view.  Pick STR 

DIAGRAM PList from the style drop down menu.  Click OK and place the Parts List. 

                            

1) Place 

dimensions 

2) Pick beam 

WB-00 

3) Select Structured 

1) Place “Leader 

Text” to TB-00 

2) Select 

View 3) Pick STR 

DIAGRAM PList 

Style 

3) Pick 

“Description” 

4) Click to add 

Text Parameter 
2) Pick “Properties-

Model” 

1) Pick Parts 

List icon 
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5. The standard drawing is complete.  To quickly create the detail drawing of BS-01, pick the 

“Replace Model Reference” icon on the “Manage” tab.  When the Replace Model Reference 

dialog box opens, click on BS-00.  Select the Browse icon, select BS-01 and double click to open.  

Pick yes at the prompt and click OK. 

              

6. BS-00 is replaced by BS-01.  Double click in the Base View.  In the Drawing View dialog box, 

change the scale to ¼”=1’ and enter.  The dimensions and Mk No’s updated automatically and 

retain their attachments. 

                           

 

Auto updated 

Parts List 

Auto update 

Title Block  

Auto updated 

Balloons 

Auto updated 

Leader Text 

Auto updated 

Dimensions 

1) Click BS-00 

2) Pick 

Browse 

icon 3) Double 

click on BS-01 
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 Create an accurate parts list using intelligent 3D models 

3D Model to BOM to Parts List 

This last section shows how Balloons, Parts List Styles, Bill of Material (BOM) and Parts List work 

together to present the information about the parts contained in the assembly in a multitude of 

arrangements. The examples shown are a glimpse into the versatility of creating Bill of Materials.  The 

first exercise shows how the Parts List Styles customizes the display of data in the Parts List.  The 

second shows how the Balloons are related to the Parts List.  Last we will look at correcting information in 

the BOM vs. correcting information in the Parts List.   

Parts List Styles 

1. Make the drawing 161-BAY-LAYOUT.dwg current and activate the “Electrical” sheet.  Select the 

Parts List icon.  From the Parts List dialog box, select the PLAN view.  Use the styles drop down 

menu to pick the “ELECTRICAL BOM PList” style.  Click OK.  Drop the Parts List in the upper 

right corner. 

               

2. As you can see, we need to alter the display of the Parts List. To do this, right click and choose 

“Edit Parts List Style”.   

                      

Right click and 

Select to edit 

Parts List Style 

1) Select 

Parts List 

icon 

2) Pick 

Plan View 

3) Select 

“ELECTRICAL BOM 

PList” from the 

styles drop down 

menu 

Styles 

Menu 
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3. Pick the Column Chooser.  Under Selected Properties, remove “INST”, “REMV” & “TRAN”.  Click 

OK.  Change the width of the “Description” column to 3.000.  Click “Save” and then “Done”. 

             

4. The Parts List must now be updated. Click on the Parts List and use the drop down styles menu 

to select “ELECTRICAL BOM PList” 

                                                       

1) Pick 

Column 

Chooser 
3) Change 

“Width” to 

3.000 

2) Remove “INST”, 

“REMV” & “TRAN” 

from Selected 

Properties 

Pick Parts List 

Style to update 
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Balloons and the Parts List     

1. Make the “Structural” sheet current.  Click on the Balloon icon and pick a structural member.  

Expand the BOM View menu.  Pick “Structured” to Balloon the sub-assemblies. (To Balloon the 

parts pick “Structured”)  Click OK and place the Balloons. 

                  

2. To place the Bill of Material, select the Parts List icon.  Select the STR DIAGRAM PList from the 

styles menu.  Place the Parts List in the upper right hand corner. 

               

1) Pick 

Balloon 

3) Pick 

“Structured” 

2) Pick Structure 

The view is 

preselected to 

match the 

Balloons 

Pick from Styles 

drop down menu 
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BOM vs. Parts List 

1. The Parts List is also controlled by the BOM Structure in the assembly Bill of Material.  Right click 

on the Parts List and pick “Bill of Material”. 

                               

2. Make the Model Data tab current.  In the BOM Structure cell next to BS-01, double click to the 

right side of the cell.  Select “Phantom” and click “Done”. 

 

3. Notice the Balloons have changed to designate the parts of BS-01 and the parts are listed in the 

Parts List. 

 

Changing the BOM Structure to 

Phantom hid the BS-01 assembly and 

listed the parts { 

Right click and 

pick ”Bill of 

Material 

1) Make 

current 

2) Double click 

3) Select 

“Phantom

” 
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4. Make the “Electrical” sheet current.  Right click on the Parts List, pick “Bill of Material” and make 

the Parts Only tab active.  On the row beginning with “O-01”, delete the manufacturer from the 

description.  Click “Done” 

 

5. The Parts List is updated automatically.  Right click on the Parts List to “Edit the Parts List”.  On 

the row beginning with “O-01”, delete “SOCBH(H01B)” in the CU CODE column.  Click OK. 

 

 

 

 

1) Make Parts 

Only tab active  
2) Delete from 

Description as shown 

Manufacturer is deleted from 

Description of Parts List  

Manufacturer is deleted 

from Description of the BOM 
Delete from Parts List 
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6. Again, the Parts List is automatically updated.  Open the “Bill of Material” to see that this last 

change to the Parts List did not affect it. 

 

 

 

 

In Conclusion 

In the Substation utility industry we use the same designs at multiple stations, except the 

designs are a little different for each station.  Inventor’s adaptability make it a perfect design tool 

for creating standard parts and assemblies that can be easily modified for specific installations. 

It all starts with the part template and a sketch.  Then parameters, constraints and iProperties 

are used to dimensionally adjust the part and the Parts List data.  When the parts are modeled 

correctly, the assemblies, drawings and Parts List carry the intelligence to automatically update 

themselves as design changes to the model are made.   

We’ve only scraped the surface of the capabilities of Inventor and SDS.   

Thank you for taking the time to participate in this class.  Feel free to contact Chip Cullum 

wcullum@nespower.com or Terri Humel thumel@nespower.com with any questions, suggestions 

or ideas. 

 

CU Code/Part Number is deleted from the Parts 

List 

CU Code/Part Number is still populated in the BOM 
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